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PREFACE

Quick Links
• Finding an address: page 5

• Viewing the Map page: page 13

• Listening to MP3 files: page 25 

• Listening to an audible book: 
page 26

• Converting currency: page 32

• Transferring files to your nüvi: 
pages 17–20 and page 55

• Adjusting the volume and 
backlight brightness: page 3

• Cleaning and storing your unit: 
pages 52–53

• Tips and Shortcuts: page 3

PREFACE

Congratulations on purchasing the Garmin® nüvi™ Personal Travel 
Assistant. 

Serial Number
Record the serial number (8-digit number on the back of the unit) 
in case your nüvi needs service or you want to purchase additional 
maps. 

Serial Number: ___ ___ ___ ___ ___ ___ ___ ___

Contact Garmin
Contact Garmin if you have any questions or if you should 
encounter any difficulty while using your nüvi. 

In the U.S.A, contact Garmin Product Support by phone at 
913/397.8200 or 800/800.1020, Monday–Friday, 8 AM–5 PM 
Central Time; or by e-mail at support@garmin.com. 

In Europe, contact Garmin (Europe) Ltd. at 44/0870.8501241.
Tell us how you like this 
manual! Fill out the Product 
Documentation Survey. Go 
to http://www.garmin.com/
contactUs/ and click Product 
Documentation Survey. 

mailto:support@garmin.com
http://www.garmin.com/contactUs/
http://www.garmin.com/contactUs/
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FIND IT AND GO!

FIND IT AND GO!
Flip up the antenna on the nüvi to get satellite signals. Then, use the Garmin nüvi to find your destination 
and go to it.

Finding Your Destination

Touch  Where to?

➊

Select a destination. 

➌

Select a category. Touch the 
arrows to see more categories. 

➋

Enjoy the route! 

➎

Touch .

➍ GPS Satellite 
Signals

The  bars in the upper left 
corner represent the satellite 
signals being received by your 
nüvi. When you see green bars, 
you have a strong signal. See page 
58 for more information 
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FIND IT AND GO!

Following Your Route
Follow the route to your destination using the Map page. As you travel, your nüvi guides you to your 
destination with vocal prompts, turn arrows on the map, and directions at the top of the Map page. If you 
depart from the original route, your nüvi recalculates the route and provides new route directions. 

Your route is marked 
with a magenta line.

Follow the arrows 
as you make turns.

A checkered 
flag marks your 
destination.

Read the driving 
instructions at 
the top of the 
page.

For more information about using the Map page, see pages 13–16. 
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FIND IT AND GO!

Adjusting the Volume and Brightness
Press and quickly release the Power button or touch  on the 
Menu page to access the Quick Settings. Move the sliders to adjust 
the volume and brightness. Touch Mute to turn the volume off. 

Locking the Screen
To prevent accidental screen taps, touch Lock. To unlock the 
screen, press the Power button. 

nüvi Tips and 
Shortcuts

• To quickly return to the Menu 
page, press and hold Back.

• Touch Help to learn more 
about the nüvi’s Travel Kit. 

• When you are listening to 
music or an audible book, 
quickly press the Power 
button twice to jump from 
any page back to the player 
page. Press Back to return to 
the previous page you were 
viewing (such as the map). 

• To extend the battery life, 
close the antenna when you 
do not need to receive GPS 
signals. If the antenna is 
closed, GPS is turned off. 

• For more tips about the 
battery, see page 57. 
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WHERE TO?

Go! Page Options

Touch  to create a turn-by-
turn route to this location. 

Touch Show Map to view this 
location on the map. 

Touch Save to save this location 
as one of your Favorites. See 
pages 9 through 12 for more 
information. 

WHERE TO? 
To learn how to perform a simple search using the  Where To 
menu, see page 1. 

Finding a Place by Spelling the Name 
From the Menu page, touch  Where to? >  Spell Name.

Select the place 
you want to visit.
Touch .

➋

Using the on-screen keyboard, 
enter letters contained in the 
name. Then touch Done.

➊

Touch  to enter numbers. Touch  to delete the last 
character entered; touch and hold  to delete the entire entry. 

TIP: In any search results list, if you do not see the place 
you want visit or you want to narrow your search results 
list, touch Spell and enter the name or part of the name. 
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WHERE TO?

Finding an Address
To find an address, touch  Where to? from the Menu page. Touch  Address. 

Select a state.

➊

Type the number 
of the address and 
touch Done. 

➌

➏

Touch a city, if 
necessary.

➍

Type the street 
name and touch 
Done.

➎

Select the street. Touch the address, if 
necessary. Touch .

➐

Touch Search All, 
or touch Spell City 
and spell the city. 

➋

 Finding an intersection is very similar to finding an address. 
Touch Intersection and enter the two street names. 
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WHERE TO?

Finding a Place Using the Map
Touch and drag anywhere on the Map page to browse the map and 
view different parts of the map. You can also touch  Where to? 
>  Browse Map. 

Tips for Browsing the Map
• Touch the map and drag to view different parts of the map. 

• Use the  and  icons to zoom in and out. 

• Touch any object on the map. An arrow appears pointing at the 
object you selected. 

• Touch Go to navigate to the selected location. 

• Touch Save to save this location to your Favorites. 

• If the GPS if turned off, touch Set Loc. to set your location to 
the selected location. 

• Touch Back to return to the previous screen.

Viewing Places on  
the Map

You can view a place you have 
found on the Map page. 

Touch Show Map.

➊

Drag the map and 
zoom in or out as 
necessary. Touch 
Back when you 
are done. 

➋
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WHERE TO?

Expanding Your Search

From the Menu page, 
touch  Where to? 
Then touch Near.

➊

Select an option. 
Touch OK.

➋

Where I Am Now—searches for places near your current 
location. 

A Different City—searches for places near the city you enter. 

My Current Route—searches for places along the route you are 
currently navigating.

My Destination—searches for places near your route 
destination.

NOTE: Your nüvi 
automatically searches 
for places near your 
current location. 
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WHERE TO?

Adding a Stop to Your Route
You can add a stop (via point) to your route. The nüvi gives you 
directions to the via point and then to your final destination. 

With a route active, touch 
Menu >  Where to? 

Touch Yes to add this stop 
before your destination. 
Touch No to make this 
your new final destination

Search for the extra stop.

Touch .

➌

➋

➍

➊

NOTE: You can add 
only one via point to 
your route.
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MY LOCATIONS

MY LOCATIONS 

Saving Places You Find

➊

After you have 
found a place, 
touch Save. 

➋

Touch OK. 

Finding Saved Places
From the Menu page, touch  Where to? >  My Locations.

Touch Favorites. Select the place 
you want to visit.

➋➊

Understanding My 
Locations

You can save all of your favorite 
places in My Locations. You can 
also save your home location in 
My Locations. 

Saving Your 
Current Location

Touch anywhere on the Map. 
An arrow points to your current 
location. Touch Save. Your 
current location is saved in your 
Favorites. 
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MY LOCATIONS

Editing Saved Places
After you save a place, you can change the name of the place and 
its symbol on the map. From the Menu page, touch  Where to? 
>  My Locations.

Touch Favorites. 

➊

Touch the Edit button. 
The Edit window opens.

➍

Touch a button to 
change the name or 
the map symbol, or 
to delete the item. 

➌

Select the place 
you want to edit.

➋
Changing the Name

To change the name, touch 
Change Name. Enter the 
new name using the on-screen 
keyboard. Touch Done. 

Changing the Map 
Symbol

To change the symbol used on 
the map, touch Change Map 
Symbol and select a symbol from 
the list. 

Deleting Saved Places
To delete this saved place, touch 
Delete. Then touch Yes. 
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MY LOCATIONS

Setting a Home Location
You can set a Home location for the place you return to most often. After you have set your Home, you can 
easily Go Home.

Touch an option. 

➌

Touch Set Home.

➋

Touch  Where to? 
>  My Locations.

➊

Going Home
Once your Home location is set, you can route to it at any time by touching My Locations and then Go 
Home.

Changing Your Home Location
Change your Home location by repeating the steps above. 
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MY LOCATIONS

Finding Recently Found Places
Your nüvi stores the last 50 of your recent finds in Recent 
Selections. The most recently viewed places appear at the top of 
the list. From the Menu page, touch  Where to? >  My 
Locations to view your recently found items. 

Touch Recent 
Selections. 

➊

Select an item from 
the list.

➋

Deleting Recently Found Places
To remove all places from the Recent Selections list, touch Clear. 
Then touch Yes. 

➊ ➋

NOTE: When you touch 
Clear, all items from the 
list are removed. It does 
not delete the actual place 
from your unit.
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VIEWING THE MAP PAGE AND OTHER PAGES

VIEWING THE MAP AND OTHER PAGES

Viewing the Map Page 
From the Menu page, touch  View map to open the Map page. The position icon  shows your 
current location. Touch and drag the map to view other areas of the map. Touch areas of the page to see 
additional information, as described below.

Touch Arrival or 
Speed to open the Trip 
Information page. See 

page 14.

Map Page while Navigating a Route

Touch Turn In to open 
the Next Turn page. See 
page 15.

Touch the text bar to 
open the Turns List. See 
page 15.

Touch  to zoom out.

Touch  to zoom in.

Touch Menu to return to 
the Menu page.

When you are following a route, your Arrival time is displayed in the lower left corner. The distance to the 
next turn (Turn In) is shown in the lower right corner. 

When you are simply driving while viewing the Map page (not following a route), your Speed is shown in 
the lower left corner. The direction you are heading (Driving) is shown in the lower right corner. 
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VIEWING THE MAP PAGE AND OTHER PAGES

Trip Information Page
The Trip Information page displays your current speed and provides helpful statistics about your trip. To 
view the Trip Information page, select Speed or Arrival on the Map page. 

Current direction 
of travel

Distance traveled 
(Odometer)

Distance to your final 
destination

Trip Information Page

Resetting Trip Information
If you want accurate trip information, reset the trip information before beginning a trip. If you make 
frequent stops, leave the nüvi turned on so it can accurately measure elapsed time during the trip. 

Select Reset Trip to reset the information on the Trip Information page. Select Reset Max to reset the 
Maximum Speed.
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VIEWING THE MAP PAGE AND OTHER PAGES

Current Route Page
The Current Route page displays turn-by-turn instructions for your entire route. Touch the green text bar 
on the top of the Map page to open the Current Route page. This page displays all turns in the route and 
the distance between turns. Select a turn on the list to view the Next Turn page for that turn. Touch Map 
to view the entire route on the map. 

Current Route Page

Direction of  
the turn

Distance to  
the turn

Upcoming turn

Distance to the 
upcoming turn

Approximate time 
left until this turn

Next Turn Page

Next Turn Page
The Next Turn page shows the turn on the map and the distance and time left before you reach the turn. 
To view an upcoming turn on the map, select Turn In on the Map page, or select any turn from the 
Current Route page. 

Use the up and down arrows to view other turns in the route. When you are finished viewing the Next Turn 
page, select Back.
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VIEWING THE MAP PAGE AND OTHER PAGES

Adding a Detour to a Route
If you need to take a detour from your current route, select 
Detour from the Menu page of the nüvi. The unit calculates a new 
route and provides you with new instructions. The nüvi attempts 
to get you back on your original route as soon as possible.

On some routes, the route you are currently taking might be the 
only reasonable option. In this case, you cannot take a detour. 

Stopping Your Route
If you want to stop your current route, return to the Menu page 
and select Stop. 

Select Menu to return 
to the Menu page.

➊

Select Stop to end 
navigation. Select Detour 
and your unit creates a 
new route if possible.

➋
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MANAGING FILES ON YOUR NÜVI

MANAGING FILES ON YOUR NÜVI

Your nüvi is able to store files, such as JPEG images and MP3 
music files. You can store files in the nüvi’s internal memory or on 
an optional SD Card. 

After you connect your nüvi to your computer, you can copy and 
paste files to the memory or an optional SD Card. Follow the four 
steps described below and on the next page.

Step 1: Insert an SD Card (Optional)
The SD card slot is located on the side of the nüvi. To insert or 
remove the card, press it in until it clicks. 

Step 2: Connect the USB Cable
1. Plug the small end of the USB cable into the connector 

located on the side of your nüvi. 
2. Connect the larger end of the USB cable to an available 

USB port on your computer. 

Inserting an SD Card

Connecting the USB Cable
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MANAGING FILES ON YOUR NÜVI

Step 3: Transfer Files to Your nüvi
1. Connect the nüvi to your computer as described on the previous page. 
2. Double-click the My Computer icon  on your computer’s desktop. 
3. Browse your computer for the file you want to copy. 
4. Highlight the file and select Edit > Copy. 
5. Open the “nuvi” or “nuvi sd” drive (see the next page for information).
6. Select Edit > Paste. The file then appears in the list of files on the nüvi memory or SD card. 

nüvi 
Removable 
Disk Drives

Step 4: Eject and Unplug the USB Cable
When you are finished transferring files, double-click the Unplug or Eject  icon in your system tray. 
Select “USB Mass Storage Device” and click Stop. Select the nüvi drives and click OK. You can disconnect 
your nüvi from your computer now. 
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MANAGING FILES ON YOUR NÜVI

Information about Your nüvi Drives
After you connect your nüvi to your computer, one or two 
additional drives appear in your computer’s list of drives: “nuvi” 
and possibly “nuvi sd.” 

“nuvi” is the available storage in the nüvi’s internal memory. “nuvi 
sd” is the SD card inserted in your nüvi. If you do not have an SD 
card inserted in your nüvi, the “nuvi sd” drive does not appear in 
the list. 

nüvi 
Removable 
Disk Drives

NOTE: On some Windows Operating Systems, the nüvi drives may not be named automatically. 
See your Windows help file or page 56 of this manual to learn how to rename the drives. 

Additional Help
For troubleshooting tips for using 
the nüvi with your computer to 
transfer files, see page 55.
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Deleting Files from Your nüvi
You can delete files from your nüvi just as you would delete files 
from your computer.

With the nüvi connected to your computer, open My Computer. 
Open your “nuvi” or “nuvi sd” drive. Highlight the file that you 
want to delete from your nüvi and press the Delete key on your 
computer’s keyboard. 

Supported File Types
• MP3 music files

• JPG image files

• AA audible book files

• GPI custom POI files from Garmin’s POI Loader (see page 51)

• GPX waypoint files from MapSource (see page 54)

• Maps from MapSource

NOTE: The nüvi does not support iTunes M4A/M4P files. 

CAUTION: If you are 
not sure about a file’s 
purpose, do NOT delete 
it. Your nüvi memory 
contains important map 
data files that should 
NOT be deleted. Be 
especially cautious of files 
located in folders entitled 
“Garmin.”
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USING THE TRAVEL KIT

➋

Touch the arrows to 
view all items in the 
Travel Kit. Touch the 
item you want to open. 

➊

From the Menu page, 
touch  Travel Kit.

USING THE TRAVEL KIT 
The travel kit provides many features that are helpful when you 
are traveling across town or across the globe. 

Using the Language Guide 
The Garmin Language Guide puts data from Oxford’s multilingual 
resources and five bilingual dictionaries in the palm of your hand. 
A sample version of the Garmin Language Guide is provided. To 
purchase the Garmin Language Guide accessory, go to the Garmin 
Web site at http://www.garmin.com/products/nuvi/ and click 
the Accessories link. You can also contact your Garmin dealer to 
purchase nüvi accessories. 

NOTE: Only nüvi 350 models can verbally translate 
words and phrases in the Language Guide. 

Loading the Language Guide
After you have received your Garmin Language Guide SD Card, 
you must load the data on your nüvi. Follow the directions on the 
package or in the nüvi help file to learn how to load the data into 
your unit. 

TIP: After you load the Garmin Language Guide onto 
your nüvi, you can use the SD card for other data, such as 
MP3s or Audible Books. 

All Dictionary, Word and Phrase 
content is © Oxford University 
Press. Voice files are © Scansoft.

http://www.garmin.com/products/nuvi/
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Translating Words and Phrases
From the Menu page, touch  Travel Kit >  Language Guide.

➊ ➌➋

Touch Language. Select the From and To 
languages and touch Back.

Touch Words and 
Phrases.

➎➍

Search for a phrase 
and touch it.

Select a category. Touch  to hear the 
translation. 

➏

 Words and Phrases Tips
• Use Keywords in Phrases to find all of the 

phrases that contain a specific word. 

• Touch Search to spell the word. 

• Touch an underlined word to replace the word. 

• Touch More Variations to change words in the 
phrase or get a different translation.

• If you cannot find what you are looking for in 
Words and Phrases, look in the Bilingual 
Dictionaries. 
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USING THE TRAVEL KIT

Using the Bilingual Dictionaries
The Garmin Language Guide provides five bilingual dictionaries. 
You can easily translate words and hear their pronunciation using 
the Bilingual Dictionaries. 

From the Menu page, touch  Travel Kit >  Language 
Guide.

➊

Touch Bilingual 
Dictionaries.

➋

Touch a translation 
option. If necessary 
touch To English. 

➌

Search for the 
word and touch it.

➍

Touch  to hear 
the word spoken.

Bilingual Tips
• Touch Search to spell the word 

or the beginning of the word. 

• Touch Legend to view 
the legend for the selected 
language. The Legend contains 
information on abbreviations, 
labels, and pronunciation 
symbols used in each dictionary.
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USING THE TRAVEL KIT

Using the Travel Guide 
Much like a paper travel guide, the Garmin Travel Guide provides detailed information about places, such 
as restaurants and hotels. Your nüvi comes with a few sample travel guide points; to purchase the Travel 
Guide accessory, go to the Garmin Web site at http://www.garmin.com/products/nuvi/ and click the 
Accessories link. You can also contact your Garmin dealer to purchase nüvi accessories. From the Menu 
page, touch  Travel Kit > Touch  Travel Guide. 

Touch a category. 
Touch a sub-category, 
if necessary.

➌

Touch an item.

➍

➊

Touch Browse.

Touch the arrows to 
view more information 
about the location. 

➎

➋

Touch a location.

Touch Go to go to the location. 
Touch Map to display this item 
on a map. 

➏

http://www.garmin.com/products/nuvi/
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USING THE TRAVEL KIT

Listening to MP3 Files 
From the Menu page, touch  Travel Kit >  MP3 Player.

Touch Back to exit the 
MP3 page to view other 
pages, such as the map. 

➍

To play the songs from 
the top of the list, touch 
Play All or touch the song 
you want to start with.

➌

Select a category. 

➋

Touch Browse.

➊

Playing Music
Touch  to adjust the volume. 

Tap  to go to the beginning of 
the song; touch and hold to skip 
back. 

Tap  to skip to the end of 
the song; touch and hold to skip 
ahead. 

Touch  to pause the song. 

Touch  to repeat. 

Touch  to shuffle. 

NOTE: The nüvi plays 
MP3 files only: it does not 
support iTunes M4A/M4P 
files. 

SHORTCUT: When you are listening to music, quickly press the Power button twice to jump 
from any page (such as the map) back to the MP3 player page. Press Back to return to the 
previous page you were viewing (for example, the map). 
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USING THE TRAVEL KIT

Listening to Audible Books 
Your nüvi provides several sample Audible books for you to listen 
to. These sample books are only portions of the book: to hear an 
entire book, purchase it from Audible.com. See pages 27—29. 

➋

Touch Browse.

➊

From the Menu page, 
touch  Travel Kit >  
Audible Book Player.

➌

Touch a book title

➍

Touch .

Moving around the 
Book

Touch  to skip a section and 
 to jump back. 

Press and hold  and  
to move forward or backward 
through the book. 

Touch the book cover art to view 
information about the book. 

Using Bookmarks
To create a bookmark, touch  
and then touch the Bookmark 
button. To view your bookmarks, 
touch  and then touch a 
bookmark. Touch  to listen to 
the book from the bookmark. 

SHORTCUT: When you are playing an audible book, quickly press the Power button twice 
to jump from any page (such as the map) back to the audible book player page. Press Back to 
return to the previous page you were viewing (for example, the map). 
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Loading Audible Books to Your nüvi
To purchase a book, go to http://garmin.audible.com and create an Audible.com account. After you create 
an account, download AudibleManager to your personal computer. Then you can purchase a book and 
download it to your nüvi. 

Before you can listen to an audible book, you must activate your nüvi. The first time you open 
AudibleManager, you are led through the activation process. See page 29 for more information. 

After activating your nüvi, follow these three steps to load an audible book to your nüvi: connect your nüvi 
to your computer, download the book to your computer, and transfer the book to your nüvi. 

Step 1: Connect your nüvi to the computer
1. Connect the mini-USB connector to the side of the nüvi. 
2. Connect the larger end of the cable to an available USB port on your computer.
3. If you want to load the book on your SD card, insert the SD card in the slot in your nüvi. 

Step 2: Download the book to your computer
Refer to AudibleManager’s Help file for detailed instructions about downloading books to your computer 
and loading them on your nüvi. 

1. From your computer’s desktop, double-click the AudibleManager icon to open 
AudibleManager. 

2. Click the Go to My Library Online  button on the top center of the window. Your 
Audible.com library opens, displaying the books you have purchased.

3. Click Get it Now to download the book to your computer. 
4. Select a format and click Download. 

http://garmin.audible.com
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Step 3: Transfer the book to your nüvi
Refer to AudibleManager’s Help file for detailed instructions about downloading books to your computer 
and loading them on your nüvi. You must first activate your nüvi before transferring books: see page 29. 

1. Open AudibleManager. 
2. Select the Internal Drive or External Drive (SD card) in the lower portion of the window. 
3. Select the book title. Click the Add to Garmin - nüvi  button in the top left corner.
4. Select how much of the book you want to load. You can load small sections at a time to save 

memory. Click OK. AudibleManager transfers the book to your nüvi. 
5. When you are finished, double-click the Unplug or Eject Hardware icon . Click Stop and 

then OK.

AudibleManager Program

Books in your 
AudibleManager 

library

Book loaded 
on your nüvi

Add to Garmin - nüvi 
icon

Go to My Library 
Online icon


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Activating Your nüvi with AudibleManager
Before you can listen to a book you have downloaded from Audible.com, you must activate your nüvi. This 
is a one time process.  

1. Disconnect your nüvi from your computer: double-click the Unplug or Eject  icon in your 
system tray. Select “USB Mass Storage Device” and click Stop. Select the nüvi drives and 
click OK. Unplug the USB cable from your nüvi. 

2. From your computer’s desktop, double-click the AudibleManager icon to open 
AudibleManager. 

3. In the “Choose your device” window, click the box next to “Garmin - nüvi” to place a check 
mark in the box. Click Next.

4. Enter your Audible user name and password. Click Next.
5. Connect your nüvi to your computer using the USB cable. Wait a few moments for 

AudbleManager to detect your nüvi. 
6. Select Activate my player(s) and click Next.
7. Please wait while AudibleManager attempts to activate your nüvi. Upon completion, you will 

receive a message saying the process has been successful. Click Finish.

NOTE: If you are unable to connect to the Internet or have any other problems activating your 
nüvi, refer to the Audible Manager Help File. Select Help from the menu and then click Help. 
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Viewing Pictures 
You can view pictures that you have stored in your nüvi using the Picture Viewer.

➊

From the Menu page, 
touch  Travel Kit.

➋

Touch  and then  
 Picture Viewer.

➍

Touch  and  
to scroll through 
the images. 

➌

Touch a picture to view 
a larger image of it.

TIP: Touch Rotate to 
rotate the image 90°. 

Viewing a Slide Show
Touch Slide Show to start a slide 
show, which displays each image 
for a few moments and then 
displays the next image. 

Touch anywhere on the screen to 
stop the slide show. 
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Using the World Clock 

Nighttime hours are 
shown in the shaded 
area. Touch World 
Clock to view the clocks 
again, or Back to exit.

➏

From the Menu page, 
touch  Travel Kit.

➊

Touch  and then 
touch  World Clock.

➋ ➌

To change a city listed, 
touch the city. 

➍

Select a new time 
zone (or city). Touch 
OK when done. 

➎

Touch World Map to 
view a map.
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Converting Currency 
From the Menu page, touch  Travel Kit. Touch  and then  Currency Converter. 

Touch the blank 
rectangle under the 
currency rate you 
want to convert.

➎

Select a currency 
and touch OK. 

➍

Select a currency 
and touch OK. 

➋

➏

Enter the number. 
Touch Done. 

Touch Clear to convert 
a different value.

➐

Touch to change 
the currency.

➊ ➌

Touch to change 
the currency.
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Updating Conversion Rates
The nüvi allows you to update the currency rates manually so that 
you are always using the most current conversion rates. From the 
Menu page, touch Travel Kit. Touch  and then  Currency 
Converter. 

➊

Touch Update.

➍

Touch Save to finish. 

➌

Touch  to erase the 
current rate. Enter a new 
rate and touch Done. 

➋

Touch the rate you 
want to update. 

TIP: Touch and hold  
to erase the entire entry.

TIP: Touch Restore 
to use the original 
conversion rate. 
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Converting Measurements 
From the Menu page, touch Travel Kit. Touch  and then  Measurement Converter. 

Select a unit of 
measure and touch 
OK.

➍

Touch From or To. 

➌

Select a type of 
measurement and 
touch OK.

➋

Touch the button.

➊

Touch the blank 
rectangle to enter a 
value. 

➎

Enter a value and 
touch Done.

➏

Touch Clear to enter 
another measurement.

➐
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Using the Calculator 
From the Menu page, touch Travel Kit. Touch  twice and 
then  Calculator. 

Enter the second 
number of your 
calculation. 

➌

Touch an operator 
(÷, x, -, or +). 

➋

Enter the first 
number of your 
calculation. 

➊

➍

Touch =. Touch  to make 
a new calculation.

➎

Touch . to add a decimal. 

Touch ± to make the number 
negative or positive. 

Touch % to make the number a 
percent (0.01). 

Touch  to clear the entry. 
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CUSTOMIZING THE NÜVI

To change nüvi settings, touch  from the Menu page. See the 
following pages for more information.

Touch  to display 
the Settings page.

➊

Select the setting 
you want to change. 

➋

Restoring Settings
To restore all settings you have 
changed, press the Restore 
Settings button, as shown below. 

To restore settings for an 
individual category, such as Map, 
touch the Restore Settings button 
on that particular page. 
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Changing the Map Settings
Map Detail—adjust the amount of detail shown on the map. 
Displaying more detail causes the map to redraw slowly. 

Map View—change the perspective of the Map page. 

• Track Up—display the map in 2 dimensions (2D) with your 
direction of travel at the top.

• North Up—display the map in 2D with North at the top.

• 3D View—display the map in 3 dimensions (3D), Track Up 
orientation. This is the default map view.

Map Info—view the maps loaded on your nüvi and their version. 

Restore—restore the original map settings.

➊

➋

➌
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Changing the System Settings
WAAS/EGNOS—enable and disable WAAS/EGNOS. For 
information about WAAS, go to http://www.garmin.com/
aboutGPS/waas.html.

Units—change units of measure to kilometers (Metric) or miles 
(Statute). 

Safe Mode—disable or enable the Safe Mode feature to improve 
driver safety. When your vehicle is moving, Safe Mode disables all 
unit functions that require significant operator attention and could 
become a distraction while driving. 

Touch Tones—disable or enable the tone that sounds each time 
you touch the screen.

Proximity Alarms—disable or enable the alerts when you 
approach Custom POIs. This option is only visible if you have 
loaded Custom POIs. See page 51 for more information about 
Custom POIs. 

About—display your nüvi’s software version number, unit ID 
number, and audio version number. This information is needed 
when you update the system software (see page 53) or purchase 
additional map data (see page 54).

Restore—restore the original system settings.

➊

➋

➌

http://www.garmin.com/aboutGPS/waas.html
http://www.garmin.com/aboutGPS/waas.html
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Changing the Time Settings
Time Format—choose a 12-hour, 24-hour, or UTC time format.

Time Zone—select a time zone or nearby city from the list. 

Daylight Saving—set to On, Off , or Auto if it is available.

Restore Settings—restore the original time settings.

➊

➋

➌
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Changing the Display Settings
Color Mode—select Daytime for a light background, Nighttime 
for a black background, or Auto to automatically switch between 
the two. 

Backlight Timeout—select the length of time the backlight 
stays on after external power is removed. Reducing the time the 
backlight stays on increases your battery life. 

Touch Screen—recalibrates (or realigns) the touch screen 
to respond properly. Touch Recalibrate and then follow the 
directions. 

PictureIt—enables you to take a screen shot when you quickly 
press and release the Power button. The screen shots are saved in 
the “PictureIt” folder on your “nuvi” drive. 

NOTE: When PictureIt is On, the Quick Settings screen 
does not open when you press the Power button. 

➊

➋

➌
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Changing the Navigation Settings
Route Preference—select a preference for calculating your 
route. Select Faster Time to calculate routes that are faster to drive 
but can be longer in distance. Select Shorter Distance to calculate 
routes that are shorter in distance but can take more time to drive.

Vehicle—specify your vehicle type to optimize routes. 

Avoidances—touch the Enabled button to 
access the road types. Select the road types 
you want to avoid on your routes. The nüvi 
uses these road types only if alternative 
routes take you too far out of your way or if 
no other roads are available. If you have an 
FM TMC Traffic Receiver, you can also avoid traffic incidents.

Attention Tone—turn on or off the attention tone.

Voice Prompts—select when you want to nüvi to announce route 
navigation and system status. 

Restore Settings—restore the original navigation settings.

➊

➋

➌
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Changing the Language Settings
Text Language—change all on-screen text to the selected 
language. Changing the Text Language does not change the 
language of map data, such as street names and places or user-
entered data. 

Voice Language—change the language for all voice prompts 
and messages. Your nüvi contains two different types of voice 
languages: text-to-speech and pre-recorded. 

Languages noted with a person’s name are text-to-speech 
(TTS) voices: for example, American English-Jill is a text-to-
speech voice. The text-to-speech voices “read” and “speak” the 
same words that are displayed on the nüvi. The voices have an 
extensive vocabulary, and they pronounce the street names as 
you approach turns. 

The pre-recorded voices have a limited vocabulary and do not 
speak names of locations or streets. 

Restore Settings—restore the original language settings.

➊

➋

➌



Garmin © 2005 43 nüvi Owner’s Manual

FM TMC TRAFFIC INFORMATION

FM TMC TRAFFIC INFORMATION 
Using an optional Garmin FM TMC Traffic Receiver, your nüvi can 
receive and use traffic information broadcast over the FM Radio 
Data System (RDS). When a traffic message is received, your unit 
displays the event on the map and can change your route to avoid 
the traffic incident. For more information about the FM TMC 
Traffic Receiver, visit the Garmin Web site (www.garmin.com). 
For participating subscription providers, refer to the Garmin Web 
site at http://www.garmin.com/fmtraffic. 

Connecting the FM TMC Traffic 
Receiver to Your nüvi
Place your nüvi in the auto mount and plug into the 12-volt 
adapter. Plug the Traffic Receiver’s mini-USB cable into the mini-
USB connector located on the side of the nüvi. 

NOTE: You can only access the traffic information and 
settings if the nüvi is connected to external power and an 
FM TMC Traffic Receiver, such as a GTM 10. 

Connecting the FM TMC 
Traffic Receiver to the nüvi

www.garmin.com
http://www.garmin.com/fmtraffic


Garmin © 2005 44 nüvi Owner’s Manual

FM TMC TRAFFIC INFORMATION

Viewing Traffic Events

➋

Select an item to 
view details.

➌

Select an option.

➊

From the Menu 
page, touch .

Avoiding Traffic
The map page displays a  when there is a traffic event on your current route or on the road you are 
driving. When you are following a route, touch the  to avoid the traffic. 

➋

Select an item to 
view details.

➌

Touch Avoid.

➊

From the map 
page, touch .
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Traffic Symbols
North American 

Symbols Meaning International 
Symbols

Road Condition

Road Construction

Congestion

Accident

Incident

Information

Color Code
The bars to the left of the traffic symbols indicate the severity of 
the traffic incident:

 = Low severity; traffic is still flowing.

 = Medium severity; traffic is a bit congested.

 = High severity; traffic is heavily congested or stopped. 

Traffic Events List

Color code
Traffic Symbol
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Adding a Subscription
Your FM TMC Traffic Receiver may have a trial subscription, or you may be in an area with free 
service. You can also add subscriptions to expand your service area. You will need your FM TMC Traffic 
Receiver’s Unit ID; see below for directions. Go to http://www.garmin.com/fmtraffic to purchase a traffic 
subscription and obtain a 25-character traffic subscription code. 

➍

Touch Next. 

➎

Enter the code and 
touch Done.

➏

Touch Done.

➌

Touch Add. 

➊

From the Menu 
page, touch .

➋

Touch Setup.

http://www.garmin.com/fmtraffic
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Mounting Your nüvi
For a tight grip, clean and dry your windshield before mounting the suction cup. 

To mount the suction cup mount:
1. Place the suction cup on the windshield. 
2. Flip the lever back, toward the windshield. 
3. Open the antenna. Fit the bottom of your nüvi into the cradle.
4. Tilt your nüvi back until it snaps in place. If necessary, rotate the cradle. 
5. Plug the small end of the cable into the back of the mount; plug the other end into a 12/24-

Volt receptacle in your vehicle.

➌

➍
➊

➋

windshield

➎

Mount the Suction Cup Mount Place the nüvi in the Mount Plug in the Cable
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Mounting the nüvi on Your Dashboard
Use the enclosed mounting disk to mount your unit to the dashboard. California drivers, use the enclosed 
disk to comply with California regulations: see the nüvi Product Information Sheet that came in the box 
for more information. 

Important: The permanent mounting adhesive is extremely difficult to remove after it is installed. 

To install the mounting disk:
1. Clean and dry the dashboard where you will 

place the disk.
2. Remove the backing from the permanent 

mounting adhesive on the bottom of the disk 
and place the disk on the dashboard.

3. Place the suction cup mount on top of the 
disk

4. Flip the suction lever down to secure the 
suction cup mount to the disk.

Disk

Suction 
cup mount

Suction 
lever
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Removing the Unit and the Mount
1. To remove the unit from the mount, press 

the tab on the bottom of the cradle up. 
2. Lift the unit off of the mount.
3. To remove the suction cup from the 

windshield, flip the lever toward you. 
4. Pull the tab on the suction cup toward you.

Removing the Cradle from the Mount
To remove the cradle from the mount arm, turn the cradle to one 
side. The cradle will snap off the ball socket. 

To replace the cradle, snap the cradle on the ball socket. 

➊

➋

➌

➍



Garmin © 2005 50 nüvi Owner’s Manual

APPENDIX

Resetting Your nüvi
If your unit locks up (freezes up), press the Power button to turn 
off the unit, then press again to turn the unit back on. If this does 
not help, reset your nüvi. 

To reset the nüvi:
1. Raise the antenna.
2. Press the Reset button. 

➊

➋

Clearing User Data
Hold your finger on the upper 
right corner of the nüvi’s screen 
while turning on the nüvi. Keep 
your finger pressed until the pop-
up window appears. Touch Yes to 
clear all user data. 

All original settings are restored. 
Your Recent Selections and 
audible bookmarks are also 
deleted. 
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CAUTION: Garmin is 
not responsible for the 
consequences of using a 
custom POI database or 
the accuracy of the safety 
camera or other custom 
POI database. 

Custom POIs (Points of Interest)
Your nüvi accepts custom points of interest (POI) databases, 
available from various companies on the Internet. Some custom 
POI databases contain alert information for points such as 
safety cameras and school zones. Your nüvi can notify you with a 
proximity alarm when you approach one of these points.

After downloading your POI database, use the Garmin POI Loader 
to install the POIs into your unit. The POI Loader is available at 
http://www.garmin.com/products/nuvi. Select Updates and 
Downloads. 

Using the POI Loader program, you can store the Custom POIs 
on your “nuvi” drive or your SD card. You can also customize the 
proximity alert settings for each POI using the POI Loader. Refer 
to the POI Loader Help File for more information; press F1 to 
open the Help File. 

To view your Custom POIs, touch My Locations > Custom 
POIs. 

To delete the Custom POIs from your nüvi, touch Where To? 
from the Menu page. Touch My Locations > Delete All. Touch 
Yes to delete all of your Favorites and your Custom POIs. 

Adjusting the  
Proximity Alarms

To turn on or off the proximity 
alarms, from the Menu page, 
touch  > System > Proximity 
Alarms. 

When the Proximity Alarms are 
on, your nüvi chimes when you 
approach a Custom POI. 

http://www.garmin.com/products/nuvi/
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Caring for Your nüvi 
Your nüvi contains sensitive electronic components that can be permanently damaged if exposed to 
excessive shock or vibration. To minimize the risk of damage to your nüvi, avoid dropping your unit and 
operating it in high shock/vibration environments.

Cleaning the Unit
The nüvi is constructed of high quality materials and does not require user maintenance other than 
cleaning. Clean the unit’s outer casing (not the touch screen) using a cloth dampened with a mild detergent 
solution and then wipe dry. Avoid chemical cleaners and solvents that can damage plastic components.

Cleaning the Touch Screen
Clean the touch screen with a soft, clean, lint-free cloth. Use water, isopropyl alcohol, or eyeglass cleaner, 
if needed. Apply the liquid to the cloth and then gently wipe the touch screen.

Protecting Your nüvi
Follow the cautions below to protect your nüvi from damage:

• Do not store the nüvi where prolonged exposure to extreme temperatures can occur (such as in the 
trunk of a car), as permanent damage may result. 

• Do not expose the nüvi to water. Contact with water can cause this unit to malfunction.
• Do not leave your nüvi in plain sight when you leave your vehicle. Take your unit with you or remove it 

from view to avoid theft.
• Though a PDA stylus can also be used to operate the touch screen, never attempt this while operating a 

vehicle. Never use a hard or sharp object to operate the touch screen or damage may result. 
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Using the nüvi Indoors
Close the antenna to turn off GPS and use your nüvi indoors. Use this setting when you are practicing 
using the unit or using the Travel Kit features, such as using the MP3 player. 

Using a Remote Antenna
You can use an optional external remote antenna (Garmin GA 27C). This is very helpful when operating 
the unit in a vehicle with a coated windshield or an in-screen (in the window) heating system, which can 
block GPS signals. Connect the antenna to the connector located on the back of the nüvi. To purchase, go 
to the Garmin Web site at http://www.garmin.com/products/nuvi and select the Accessories link. 

Changing the Fuse
An AGC/3AG 2 Amp, high-breaking capacity, 1500 A-rated fuse is located at 
the tip of the vehicle adapter. Periodically, you may need to change the fuse. 
Unscrew the black, round end piece and replace the fuse. 

Charging the nüvi
You can charge the nüvi using the USB cable (see page 17) or the 12/24-Volt car adapter connected to the 
suction mount. 

Updating the nüvi Software
Garmin periodically updates its software and map data. If you register your unit, you will receive 
notification of software and map updates. To see if an update to the nüvi’s system software is available, go 
to http://www.garmin.com/products/nuvi and select Software Updates. To see if an update for your 
map software is available, go to http://www.garmin.com/unlock/update.jsp. 

Unscrew

http://www.garmin.com/products/nuvi/
http://www.garmin.com/products/nuvi/
www.garmin.com/unlock/update.jsp
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Purchasing Additional MapSource Maps
You can purchase additional MapSource map data from Garmin and load the maps on your nüvi’s internal 
memory or on an optional SD card. Follow the instructions that came with the new map data to properly 
install the maps to your computer and nüvi. In order to enable additional maps, you need your unit ID (see 
page 38) and serial number (see page i). To load maps to your nüvi memory or SD card, select the name 
for your “nuvi” drive or SD card drive. Refer to the MapSource help file for more information about using 
MapSource and loading maps on your Garmin GPS. 

Loading MapSource Waypoints on Your nüvi
Using MapSource, you can save locations (also called waypoints) and transfer them to your nüvi. For more 
information about creating waypoints in MapSource, see the help file (press F1 to open the help file). 

After you have created the waypoints, select File > Save. Select GPS eXchange Format (*.gpx) for the 
Save as Type. Click the Save button. 

With your nüvi connected to your computer, copy the *.gpx file into in the Garmin\Waypoints folder in 
the “nuvi” drive. The waypoints you created in MapSource are now in My Locations > Favorites. 

Viewing Your Saved Locations in MapSource
You can also view the locations you have saved in your nüvi using the MapSource program. 

In MapSource, select File > Open. Select GPS eXchange Format (*.gpx) for Files of Type. Browse to 
find the Garmin\Waypoints folder on your “nuvi” drive. Select Waypoints.gpx and click Open. 
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USB Interface Troubleshooting
Problem/Question Solution/Answer

How do I know my nüvi 
is in USB Mass Storage 
Mode?

When your nüvi is in USB Mass Storage Mode, a picture of a nüvi 
connected to a computer is shown. Also, you should see a new 
Removable Disk Drive listed in My Computer. 

My computer never 
senses that the nüvi is 
connected.

1. Unplug the USB cable from your computer. 
2. Turn the nüvi off and then back on again. 
3. Plug the USB cable into your computer. The nüvi automatically 

turns on and goes into USB Mass Storage Mode. 

I cannot find any drives 
named “nuvi” in my list 
of drives.

Try the solution listed above. 
If you have several network drives mapped on your computer, 
Windows may have trouble assigning drive letters to your nüvi drives. 
Follow the steps on the following page to assign your drive letters. 

I keep getting a message 
saying “Unsafe Removal 
of Device” when I unplug 
the USB cable.

When you are ready to disconnect your nüvi from your computer, 
double-click the Unplug or Eject  icon in your system tray. Select 
“USB Mass Storage Device” and click Stop. Select the nüvi drives and 
click OK. You can disconnect your nüvi from your computer now. 

How can I rename my 
nüvi drives?

1. Open My Computer. 
2. Select the drive you want to rename. 
3. Right-click your mouse and select Rename. 
4. Type the new name and press the Return key. 
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How do I map my nüvi 
drives in Windows?

1. Turn off your nüvi. 
2. Plug in the USB cable to the nüvi and your computer. Your nüvi 

will automatically turn on. 
3. Click Start > Settings > Control Panel > Administrative 

Tools > Computer Management > Storage > Disk 
Management. 

4. Click a nüvi removable disk drive (either the internal memory or 
your SD Card drive). Right-click your mouse and select Change 
Drive Letter and Path….

5. Select Edit…, select a drive letter from the drop-down list, and 
click OK. 

nüvi Troubleshooting
Problem/Question Solution/Answer

My battery gauge does 
not seem accurate.

Allow the unit to fully discharge and then fully charge it (without 
interrupting the charge cycle). See page 57.

The touch screen is not 
responding to my taps 
properly.

Calibrate the screen. From the Menu page, touch Settings > 
Display. Touch the Recalibrate button and follow the on-screen 
instructions. 
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Battery Gauge
The battery icon in the upper right 
corner of the Menu page indicates 
the status of the internal battery. 

Battery 3/4 full

Full battery

Battery 1/2 full

Battery 1/4 full

Battery charging  
or connected to  
external power

Periodically, you might notice 
that the battery gauge is not 
completely accurate. To increase 
the accuracy of the battery gauge, 
fully discharge the battery and 
then fully charge it without 
interrupting the charging. For 
best results, do not unplug the 
nüvi until it is totally charged. 

Battery Information 
Your unit contains an internal (non-removable) lithium-ion 
battery. Contact your local waste disposal department for 
information on properly disposing of the unit. 

Battery Tips
• Your nüvi’s battery should last 4 to 8 hours depending on 

usage. The battery gauge indicates the status of the battery. 

• To extend the battery life, reduce the time the backlight 
stays on. From the Menu page, select Settings > Display > 
Backlight Timeout to change the setting. See page 40.

• To extend the battery life, close the antenna when you do not 
need to receive GPS signals. 

• To increase the accuracy of the battery gauge, fully discharge 
the battery and then fully charge it. You should not need to do 
this very often. See “Battery Gauge” in the side bar for more 
information. 

• To maximize the life of the lithium-ion battery, do not leave 
your nüvi direct sunlight and avoid prolonged exposure to 
excessive heat. 
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About Satellite Signals
Your nüvi must acquire satellite signals to operate. If you are indoors, near tall buildings or trees, or in a 
parking garage, the nüvi cannot acquire satellites. Go outside to an area free from tall obstructions to use 
your nüvi, or close the antenna to turn off GPS and use it indoors. 

When the nüvi has acquired satellite signals, the signal strength bars on the Menu page are green . 
When it loses satellite signals, the bars turn red or disappear . 

Touch the signals strength bars in the upper left corner of the Menu page to view GPS information. Touch 
any where on the screen to return to the Menu page. 

GPS StatusSpeed

Satellite signal strength barsSky view

ElevationDirection of travel

The sky view shows the satellites you are receiving. The satellite signal strength bars indicate the strength 
of each satellite you are receiving. 

For more information about GPS, visit the Garmin Web site at http://www.garmin.com/aboutGPS.

http://www.garmin.com/aboutGPS
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Technical Specifications
Size: 3.87” W x 2.91” H x 0.87” D (98.3 x 73.9 x 22.1 cm)

Weight: 5.1 oz. (144.6 g)

Display: 3.5” (8.89 cm), 2.8” W x 2.1” H (7.2 cm x 5.4 cm);  
320 x 240 pixels; QVGA TFT landscape display with white 
backlight and anti-glare touch screen

Case: Not waterproof or IPXO

Temperature range: 32°F to 140°F (0°C to 60°C)

Data storage: Internal memory and optional Removable SD 
card. Data stored indefinitely

PC interface: USB mass storage, plug-and-play

Power Input: 12/24 VDC

Usage: 15 W max. @ 13.8 VDC

Battery life: 4 to 8 hours depending on usage

Headphone jack: Standard 3.5 mm 

For a complete list of specifications, visit the Garmin Web site at 
http://www.garmin.com/products/nuvi/spec.html.

GPS Performance 
Specifications

Receiver: WAAS enabled

Acquisition times*: 
Warm: <1 sec 
Cold: <38 sec 
Factory Reset: <45 sec
*On average for a stationary 
receiver with an open sky view

Update rate: 1/sec, continuous

GPS Accuracy:
Position: <10 meters, typical
Velocity: 0.5 meter/sec RMS

GPS (WAAS) Accuracy:
Position: <5 meters, typical
Velocity: 0.5 meter/sec RMS

http://www.garmin.com/products/nuvi/spec.html
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Software License Agreement
BY USING THE nüvi, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THE 
FOLLOWING SOFTWARE LICENSE AGREEMENT. PLEASE READ THIS AGREEMENT CAREFULLY.

Garmin grants you a limited license to use the software embedded in this device (the “Software”) in binary 
executable form in the normal operation of the product. Title, ownership rights, and intellectual property 
rights in and to the Software remain in Garmin.

You acknowledge that the Software is the property of Garmin and is protected under the United States of 
America copyright laws and international copyright treaties. You further acknowledge that the structure, 
organization, and code of the Software are valuable trade secrets of Garmin and that the Software in source 
code form remains a valuable trade secret of Garmin. You agree not to decompile, disassemble, modify, 
reverse assemble, reverse engineer, or reduce to human readable form the Software or any part thereof or 
create any derivative works based on the Software. You agree not to export or re-export the Software to 
any country in violation of the export control laws of the United States of America.

NOTE: The Garmin nüvi has no user-serviceable parts. Should you ever encounter a problem 
with your unit, take it to an authorized Garmin dealer for repairs. 

NOTE: The nüvi is fastened shut with screws. Any attempt to open the case to change or 
modify the unit in any way voids your warranty and may result in permanent damage to the 
equipment.
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INDEX

Symbols
2 Dimensional 37
3 Dimensional 37

A
About Button 38
Adding a Stop to Your Route 8
Attention Tone 41
Audible Books 26

bookmarks 26
playing 26
transferring 28

Audio version 38
Avoiding road types 41
Avoiding Traffic 41, 44

B
Backlight Timeout 40
Battery 57
Bilingual Dictionaries 23
Bookmarks 26
Brightness 3
Browse the Map 6

C
Calculator 35
Caring for your nüvi 52
Changing the settings 36
Clearing User Data 50

Color Mode 40
Computer connection 17
Connecting the USB Cable 17
Contact Garmin i
Converting Currency 32

updating conversion rates 33
Converting Measurements 34
Currency 32
Current Location, saving 9
Current Route Page 15
Customizing your nüvi 36

color mode 40
language 42
map 37
navigation 41
system setup 38
time 39

Custom POIs (Points of 
Interest) 51

D
Daylight Saving 39
Delete

character 4
custom POIs 51
files from the nüvi 20
recent finds list 12
saved places 10
user data 50

Detour, adding 16
Disconnecting your nüvi 18, 55

Disk Drives 18, 19
Driving directions 15

E
Editing saved places (My 

Locations) 10
EGNOS 38
Eject USB 18
Expanding your search 7

F
Favorites 9, 10
Files

deleting 20
managing 17
supported types 20
transferring 18

Finding places
address 5
by name 4
intersection 5
item on the map 6
recent selection 12
saved item 9

Find a place near another 
place 7

FM TMC Traffic Receiver 43–
46

Following your route 2
Fuse, changing 53

G
Go! 4
Go Home 11
GPS 1, 3, 57

information 58
Green bars 1

H
Help 3
Home Location 11

K
Keyboard 4

L
Language Guide 21, 22, 23
Language settings 42
Legend, Bilingual Dictionary 23
License Agreement 60
Listening to music 25
Locking the Screen 3

M
M4A/M4P 25
Map 6, 13

browse 6
customize 37
zoom 6, 13

MapSource 54
Map Info Button 37



Garmin © 2005 62 nüvi Owner’s Manual

INDEX

Map software
update 53
version 37

Map symbol 10
Map view 37
Measurements 34
Metric units 38
Mounting your nüvi 48
MP3 25
Mute 3
My Locations 9, 10, 11, 12

Favorites 9
Go Home 11
Recent Selections 12

N
“nüvi” drive 18, 19
“nüvi sd” 18, 19
Narrow your results list

spell the name 4
Navigation settings 41
Near Button 7
Next Turn Page 15
North Up 37

O
On-screen keyboard 4

P
PictureIt 40
Pictures 30
Playing Music 25

POI 51
Position icon 13
Present Location, saving 9
Proximity Alarms 38, 51

Q
Quick Settings 3

R
Recalibrate touch screen 40
Recently-Found places

delete 12
find 12

Removable Disk Drives 18, 19
Resetting your nüvi 50
Reset Max Speed 14
Reset Trip 14
Restoring Settings 36
Routing preferences 41

S
Safety camera database 51
Safe Mode 38
Satellite Signals 1, 58
Save

current location 9
places you find 4, 9

Saved Places
delete 10
edit 10

School zone database 51
Screen shots 40

SD Card 17, 59
disk drive 18, 19

Serial Number i
Set your Location 6
Shortcuts 3, 25, 26
Show Map 4, 6
Software License Agreement 60
Software version 38
Spell the name of a place 4
Stop navigation 16
Stop USB 18
Storing your nüvi 52
Supported File Types 20
System Setup 38

T
Taking screen shots 40
Text Language 42
Time 39
Touch screen

cleaning 52
recalibrating 40

Touch tones 38
Track Up 37
Traffic 43

avoid 41, 44
events 44
subscription 46
symbols 45

Transferring Files 18
Translating Words and 

Phrases 22
Travel Kit 21–35
Trip Information Page 14
Troubleshooting 56

USB 55
Turn-by-turn directions 15
Turn off the beeping 38

U
Units 38
Unit ID 38
USB 18

troubleshooting 55
User Data, deleting 50
Using the nüvi Indoors 53

V
Vehicle Type 41
Viewing Places on the Map 6
Viewing the Map 13
Voice Language 42
Voice Prompts 41
Volume 3

W
WAAS 38–42
Words and phrases 22, 23
World Clock 31

Z
Zoom 6, 13



For the latest free software updates (excluding map data) throughout the life of your  
Garmin products, visit the Garmin Web site at www.garmin.com.
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